1.What does Bank Reconciliation mean? 
A) It means to reconcile with the banker after getting into a fight for bank errors
B)Verifies which transactions have cleared or not to verify that the amounts in the QuickBooks register match the bank
C)It automatically downloads the bank transactions so you do not have enter any data manually

2.Reporting revenues when they are earned (even if the money is not yet received at the time it is earned) is known as the _________________ basis of accounting?
 
3.A check that has been written and recorded in the general ledger Cash account, but has not yet cleared the bank account is known as an ____________________ check?

4.Which of the following accounts is a permanent account?
A) Temporary Investments
B) Wages Expense

5.What is the best way to record a single vendor payment to a vendor to pay multiple bills?
A) This is not possible, you must pay each bill with a different check
B) First Enter each bill separately using the Enter Bills Function, then go to Pay Bills and check all the open bills to pay, after clicking on each bill, QuickBooks will calculate the total amount to pay.
C) Go to Write Check and create all the bills to be paid from this module
D) None of the Above

6.When viewing a summary style financial report, such as a Profit and Loss Standard, what happens when you double click on an the amount shown on any account?
A) It allows you to see the formula of the calculated amount
B) It shows another report with multiple transactions that compose that number
C) It takes you to the General Ledger spreadsheet where you can modify the amounts
D) None of the Above

7.How does Accrual Basis of Accounting differ from cash basis:
A) Cash basis pays the least amount of taxes when you receive all the payments in cash because they are not reported as income.
B)Accrual basis helps you recognize Income when is earned, using an Invoice and Accounts Receivable, regardless of when it is paid.  Cash basis recognizes the income only when the invoice is paid.
C) Accrual is only for large companies that accrue liabilities, all small businesses are forced be using cash basis by the IRS.
D) They do not differ from the IRS's perspective.

8. Which account is closed at the end of the accounting year?
A) Miscellaneous Expense
B) Deferred Charges

9.What is the difference between reconciling a Bank Account and a Credit Card Account?
A) You can only reconcile bank accounts, QuickBooks will not let you reconcile Credit Card Accounts.
B) They are essentially the same process, these are just two different types of accounts, but the reconciliation process is very similar.  Banks typically can have outstanding checks, but credit cards wouldn't.
C) You must setup a different company file for every account being reconciled.

10.When receiving payments in QuickBooks, you must specify which of the following?
A) Which Labor account the payment will decrease
B) Where the payment goes (Undeposited Funds, Checking, etc)
C) What company is in the "Pay to the order of" field

11.Once the EasyStep Interview is complete, which of the following is NOT recommended?
A) Create a backup copy of the company file
B) Enter historical transactions
C) Delete previous company file backups

12.It is possible to manually sort a list entry by:
A) Right-click on the name, then select Sort by Selection
B) Click the appropriate column heading
C) Clicking on the diamond to the left of the name then dragging the name up or down the list

13.Accounts Payable, Wages Payable, and Notes Payable are examples of ___________________ accounts?
14.Which version of QuickBooks supports more than five users?
A) Simple Start and higher
B) Premier and higher
C) Enterprise Solutions only

15.What is "Undeposited funds"?
A) These are all the payments received but were not marked as deposited in the bank via QuickBooks 
B) These are the funds you have deposited in the bank, but the bank as not cleared yet as available for use 
C) All of the Above
D) None of the Above

16.What does "Billable" Time and Expenses mean?
A) These are expenses to which you receive a paper bill for
B) These are expenses you would like to get reimbursed for by your clients
C) This is time spend by an employee or subcontractor that will be INVOICED to your client later on
D) Both C and D are correct

17.How do "Enter Bills -> Pay Bills" feature differ from "write check" feature?
A) Enter bills for expenses recognized on the bill's date and use the Pay bills option to pay in the future, utilizing the Accounts Payable account.  Write check is only used to create expenses that are immediately paid, bypassing Accounts Payables.
B) Enter bills for expenses recognized only on the day they get paid using the Pay bills option.  Write check recognizes the expenses when the check clears the bank
C) Enter Bills are assets that are converted to liability with the Pay bills function.  Write checks records expenses paid by check only
D) They all serve the same function and affect the accounting the same

18.What does Accounts Receivable mean?
A) It means these are values customers owe us, typically from open invoices.
B) These are the total amount of money owed to our vendors from open bills.
C) These are the invoices that were pre-paid before the product was delivered.
D) None of the Above

19.Estimates and Purchase orders are known as:
A) Posting Transactions - affect accounting results
B) Non-Posting Transactions - Do not affect accounting results
C) Non-Deductible Transactions - these are not deductible from taxes based on special IRS rules
D) None of the above

20.You did not set the Closing Date. Which of the following situations could the Closing Date have prevented?
A) A user deleted an invoice in the prior year. Last year's financial statements have now changed
B) You deleted an invoice from earlier today. Today's sales reports have changed
C) You accidentally restored a backup copy of your data file and it overwrote your current data file

21.How do you export QuickBooks reports into excel?
A) You cannot export ANY data from QuickBooks to Excel
B) You must pull the desired report, then click on Excel, then Create new Worksheet
C) You can view QuickBooks data in excel, but cannot manipulate the data because it is not in spreadsheet format
 D) None of the, Above

22.Which forms can be customized, such as adding a logo, in QuickBooks?
A) Checks and Bill Payments
B) Estimates, Sales Orders, Invoices, Sales Receipts, Statements, Credit Memos, and Purchase Orders
C) Deposit Slips
D) Bank Reconciliation Report
E) All of the Above
F) None of the above

23.A ___________ discount is usually a percentage that is deducted from a catalog's list price?
 
24.What does Memorized Transactions mean?
A) This is when you tell QuickBooks to save a particular transaction to be entered the same way later on via a Reminder or automatically enter.
B) This is a report that shows all the transactions that QuickBooks needs to remember to automatically reconcile when is downloaded from the Bank.
C) All of the Above are correct.

25.What does it mean when you have a balance in Undeposited Funds?
A) It means you deposited the money in the bank, but the funds are not cleared yet
B) This is the amount of cash payments that were not deposited to avoid paying taxes
C) There are any customer payment received, that have not yet been deposited via Quickbooks

26.Restoring the amount of cash on hand in the petty cash fund to the amount reported in the general ledger is known as ______________________ the petty cash fund?
 
27.The financial statement that reports assets, liabilities, and owner's equity is the _____________ ______________?

28.Where or How are items used in QuickBooks?
A) They are used to reconcile bank accounts 
B) They are used in transactions such as invoices or bills to track type of product or service being sold or purchased.
C) They are used only to track inventory items being sold.
D) They are not used in QuickBooks at all unless you turn on the items functionality
 E) None of the Above

29.What is a Sales Order?
A) Is a Non-posting transaction used to log a sale before delivering the product or service. It is very useful to create back-orders when inventory is not in stock.
B) It's a type of Bill that prepares the Accounts Payable during the order process
C) None of the Above

30.Which Reports in QuickBooks shows the activities of the company such as sales and expenses?
A) The Cashflow Analysis
B) The Balance Report
C) The Profit and Loss Report

31.The Chart of Accounts
A) It is a graphical illustration of how all the accounts affect each other in the accounting
B) Is a list of all "accounting" accounts such as income, expenses, assets, liabilities, and equity.  Where you can create new ones and edit existing ones
C) It is the place where all the bank accounts are reconciled
D) None of the Above

32.What does the HOME icon do in the Desktop Version of QuickBooks?
A)Once completed QuickBooks will create a company file on the cloud that only people with the correct username and password will be able to access
B)The Interview Questions can always be retrieved later in the future to change the settings
C)The Interview Questions can never again be retrieved for the same company file, but the preferences can be changed in the Edit, Preferences menu and Company, Company Information menu
D)Neither the Interview questions nor the preferences can be changed once the company file is set
E)None of the above

33.Estimates and Purchase orders are known as:
A)Posting Transactions – affect accounting results
B)Non-Posting Transactions – Do not affect accounting results
C)Pending Transactions – affecting accounts receivable and accounts Payable only
D)Non-Deductible Transactions – these are not deductible from taxes based on special IRS rules
E)None of the above

34.If you click on the Home icon, the following will happen?
A)QuickBooks will send a signal to your GPS with directions back to your house
B)It will take you to the homepage of your favorite website, such as google.com
C)It will close the company file and take you to the initial Open Company File menu
D)It will show the Home Screen with all the workflow icons and keep the other windows open in the background
E)None of the Above

35.What is a Sub-Account and what is it used for?
A)It’s an account of less value as non-subaccounts and it shows which accounts have the most value
B)It’s used for savings accounts and non-subaccounts are used for checking accounts
C)It is an account within another account (or belonging to a parent account) used to represent higher level of detail of a parent account.  Sub-Accounts can be collapsed or expanded in reports.
D)It is a non-posting account used to input all non-posting transactions
E)None of the Above

36.What are some of the different types of items?
A)Income and Expense items
B)Itemized deduction and Standard Deduction
C)Items for sale and items non-for-sale
D)Inventory, Non-Inventory, Service, and Other charges
E)Depreciable, Non-Depreciable, Taxable, and Non Taxable

37.Where or How are items used in QuickBooks?
A)They are used in transactions such as invoices or bills to track type of product or service being sold or purchased.
B)They are used only to track inventory items being sold.
C)They are not used in QuickBooks at all unless you turn on the items functionality

38.When an opening balance is entered for new balance sheet accounts, which account is used as the offset?
A) Reconciliation discrepancies
B) The checking account
C) Opening balance equity

39.In the Desktop Version of QuickBooks, when Setting up a New Company File with the Step-by-Step Guide, it is important to keep in mind: 
A) The Interview Questions can always be retrieved later in the future to change the settings
B) The Interview Questions can never again be retrieved for the same company file, but the preferences can be changed in the Edit, Preferences menu and Company, Company Information menu
C) Neither the Interview questions nor the preferences can be changed once the company file is set
D) None of the above

40.By default, Net Income for the prior year flows into which account in the next year?
A) Retained Earnings
B) Liabilities
C) Accounts Receivable

41.When you should not use the "Write Check" Function in QuickBooks?
A) To enter debit card charges on your checking account
B) To enter Checks writing from your checking account
C) To Pay an open Bill that was previously inputted in the Enter Bills module
D) All of the above situations are fine for the Write Checks function

42.Items recorded in the general journal are in order by 
A) Date
B) Type of transaction

43.Where do you turn on QuickBooks account numbers?
A) Preferences window
B) EasyStep Interview
C) Chart of Accounts window

44.What are the most used reports in QuickBooks/Accounting to understand the financial health of the business?
A) The Accounting Accuracy Reports
B) The Profit & Loss (or Income Statement) and Balance Sheet
C) The Cashflow Projection Report
D) The Owner's Distribution Report
E) The Financial Summary Report
F) None of the Above

45.What is the best way to record a customer prepayment before the invoice has been created for the sale of inventory items on backorder?
A) Create a Sales Order, go to Receive Payment, and put in the memo field which SO is being prepaid
B) Create a Sales Order, Go to Record Deposit, choose the Customer that prepaid you, put in the account: Accounts Receivable, and put in the memo filed the SO to apply the payment to
C) All of the Above are Correct
D) Only A and C are Correct
46.The classifications for contributions received by a not-for-profit organization are permanently restricted, temporarily restricted, and __________________________?
47.What does Bank Reconciliation mean?
A) It means to reconcile with the banker after getting into a fight for bank errors 
B) Verifies which transactions have cleared or not to verify that the amounts in the QuickBooks register match the bank
C) It matches the QuickBooks register balance with the available balance in the Bank's Website
D) It automatically downloads the bank transactions so you do not have enter any data manually

48.When you double-click on a income statement (profit and loss) account in the Chart of Accounts, what does QuickBooks display?
A) The Account Register
B) The Add New Account window
C) The Make Interactive window
D) Another report with the summary of transactions that make up that number

49.What would happen if you try to delete an item that was sold a couple of years ago, but has not been used in a while?
A) It will save a record of the past usage but delete it  from the database so you cannot edit it.
B) It will not let you delete it, instead you can make it inactive so it does not show as an option to use it. 
C) You can delete it, but your past financial statements will be affected
D) None of the Above
50.Bad Debts Expense is an income statement account used to report the losses associated with the asset account___________________ _____________________?
51.What does it mean when you have a balance in Undeposited Funds?
A) It means that there are open invoices from clients that they have not yet paid.
B) It means you deposited the money in the bank, but the funds are not cleared yet
C) This is the amount of cash payments that were not deposited to avoid paying taxes
D) There are any customer payment received, that have not yet been deposited via Quickbooks
52.Prior to approving a vendor's invoice for payment, the invoice, receiving ticket, and _______________ order should be compared?
53.Where can you view AND edit journal entries?
A) Balance Sheet Standard
B) Make General Journal Entry window
C) Custom Transaction Detail Report

54.If you click on the Home icon, the following will happen:
A) It will take you to the homepage of your favorite website, such as google.com
B) It will close the company file and take you to the initial Open Company File menu, where you can select which company file you would like to open.
C)It will show the Home Screen with all the workflow icons and keep the other windows open in the background
D) You can actually customize the Home Icon to do any function listed above
E) None of the Above

55.What account(s) does an Inventory item post to?
A) It just posts to the Inventory account when purchased and posting the sales account when sold
B) It posts the inventory asset account when purchased, then posts both to the income and cost of goods sold account when sold. 
C) It posts to the Inventory Account Report
D) None of the Above

56.Which certain types of accounts increase when you debit them?
A) Checking, expenses, and income
B) Assets, cost of goods sold, and expenses
C) Income, assets, and liabilities

57.Which menu would you access to create a new company budget?
A) The File menu
B) The Company menu
C) The List menu

58.When viewing a summary style financial report, such as a Profit and Loss Standard, what happens when you double click on an the amount shown on any account? 
A) It will take you to one transaction where you can edit total amount
B) It shows another report with multiple transactions that compose that number
C) It takes you to the General Ledger spreadsheet where you can modify the amounts
D) None of the Above

59.Which transaction cannot be entered directly into an account register?
A) Invoice
B) Credit Card Charge
C) Bank Service Charge

60.What are some of the different types of items?
A) Income and Expense items
B) Items for sale and items non-for-sale
C) Inventory, Non-Inventory, Service, and Other charges
D) Depreciable, Non-Depreciable, Taxable, and Non Taxable

61.When analyzing Financial Reports such as Balance Sheet and Profit & Loss, what is the best way to spot potential bookkeeping or classification errors?
A) Look for unusual balances, such as negative expense
B) Analyze gross margin (Costs of Goods Sold divided by Total Sales/Income) to see if the gross margin percentage is consistent with expected value.
C) All of the above are correct 
D) None of the above are correct, you must click on "Identify Accounting Errors" to do this.

62.What is "Undeposited funds"?
A) These are all the open invoices that have not been paid by your clients
B) These are all the payments received but were not marked as deposited in the bank via QuickBooks 
C) These are the funds you have deposited in the bank, but the bank as not cleared yet as available for use
D) These are all you outstanding checks written that your vendors have not deposited
E) All of the Above
F) None of the Above

63.What is a "Petty Cash" or "Cash on Hand"? (choose the best answer)
HINT: IT IS NOT AN EXPENSE ACCOUNT
A) It's an expense account where all miscellaneous cash expenses should be recorded
B) It's a "bank" account in QuickBooks where you may transfer funds from checking/savings accounts to utilize the cash to make purchases, and these purchases are logged in its own register
C) Both B and C are correct.
D) All of the above are correct

64.Which of the following is NOT a feature of QuickBooks?
A) Recipe storage
B) Write checks
C) Invoicing
65.A retailer's cost of goods sold can be computed as follows: 
beginning inventory + net purchases - ______________ _________________?
66.When beginning a Bank Reconciliation, QuickBooks will ask you to enter all of the following in except:
A) The ending bank balance
B) Checkbook balance
C) Bank service charge

67.When viewing a detail level report, such as Open Invoices Report, what happens when you double click on an the amount shown on any particular transaction?
A) It will take you to one transaction where you can view or edit the individual transaction
B) It allows you to see the formula of the calculated amount
C) None of the Above

68.What are the most used reports in QuickBooks/Accounting to understand the financial health of the business?
A) The Financial Health Report
B) Profit & Loss
C) All of the above
D) B and C only.

69.You just made the daily bank deposit which includes all payments received to date. What balance do you expect in the Undeposited Funds account?
A) The amount of that day's deposit
B) Zero 
C) The average of the previous 7 day's total deposit


70.Which amount should be added to the balance per books when preparing a bank reconciliation?
A) Bank service charge
B) Interest received on the bank account

71.On what menu do you find the chart of accounts?
A) Lists
B) Customers 
C) Banking

72.What are the most used reports in QuickBooks/Accounting to understand the financial health of the business?
A) The Accounting Accuracy Reports
B) The Daily Bank Reconciliation Report
C) The Profit & Loss (or Income Statement) and Balance Sheet
D) The Cashflow Projection Report
E) The Financial Summary Report 
F) None of the Above

73.What is the best way to record a customer prepayment before the invoice has been created for the sale of inventory items on backorder?
A) Create a Sales Order, go to Receive Payment, and put in the memo field which SO is being prepaid
B) Create a Sales Order, Go to Record Deposit, choose the Customer that prepaid you, put in the account: Accounts Receivable, and put in the memo filed the SO to apply the payment to 
C) All of the Above are Correct
D) Only A and C are Correct

74.Sales and services that are provided on credit will cause an increase in the asset account __________________ ____________________?

75.Which report helps you count inventory on-hand?
A) Physical Inventory Worksheet
B) Inventory Stock Status by Item Report
C) Inventory On-Hand Listing

76.When receiving payments in QuickBooks, you must specify which of the following?
A) Which Labor account the payment will decrease
B) What account the payment comes from
C)Where the payment goes (Undeposited Funds, Checking, etc)

77.What is the shortcut for deleting a column on a report?
A) Click and drag the diamond between column headings over the diamond to the left
B) Right mouse click on the column heading, and choose Delete
C) Apply a report filter

78.What account(s) does an Inventory item post to?
A) It just posts to the sale account when sold
B) It posts the inventory asset account when purchased, then posts both to the income and cost of goods sold account when sold.
C) It posts to the Inventory Account Report
D) None of the Above

79. If you click on the Home icon, the following will happen:
A) If your Phone is synced with QuickBooks,  it will send a signal to your GPS with directions back to your house
B) It will take you to the homepage of your favorite website, such as google.com
C)It will show the Home Screen with all the workflow icons and keep the other windows open in the background
D) You can actually customize the Home Icon to do any function listed above
E) None of the Above

80.Items recorded in the general journal are in order by
A) Date
B) Type of transaction

81.Why might you use a journal entry?
A) To enter transactions that you cannot enter with a built-in form 
B) For year-end adjustments
C) All of the above

82.The classifications for contributions received by a not-for-profit organization are permanently restricted, temporarily restricted, and __________________________?
 
83.What is a Sub-Account and what is it used for?
A)It's used for savings accounts and non-subaccounts are used for checking accounts 
B) It is an account within another account (or belonging to a parent account) used to represent higher level of detail of a parent account.  Sub-Accounts can be collapsed or expanded in reports.
C) It is a non-posting account used to input all non-posting transactions
D) Both B and C are Correct
E) None of the Above

84.What is a "Petty Cash" or "Cash on Hand"? (choose the best answer)
HINT: IT IS NOT AN EXPENSE ACCOUNT
A) It's an expense account where all miscellaneous cash expenses should be recorded 
B) It's a "bank" account in QuickBooks where cash payments from clients can be deposited  into if they are not deposited directly in the bank
C) It's a "bank" account in QuickBooks where you may transfer funds from checking/savings accounts to utilize the cash to make purchases, and these purchases are logged in its own register
D) Both B and C are correct.
E) All of the above are correct

85.What is the purpose of the Chart of Accounts?
A) It allows accountants to view your accounting records remotely
B) It is how you categorize financial transactions
C) None of the above

86.When you should not use the "Write Check" Function in QuickBooks? 
A) To enter debit card charges on your checking account
B) To enter electronic debits or ACH charges on your checking account
C) To Pay an open Bill that was previously inputted in the Enter Bills module
 
D) All of the above situations are fine for the Write Checks function

87.The name of the person or company appearing on a check after the words "Pay to the Order of" is known as the ____________?

88.Which of the following is an asset account?
A) Accounts Receivable
B) Customer Deposits

89.What does the term "Double entry accounting" mean?There are always at least two Accounts involved in every financial transaction
90.What is true regarding the �EasyStep Interview" process?
a. Quickbooks allows converting data from Peachtree and Quicken.
b. Many users can be involved in the setup of �EasyStep Interview" at the same time.
c. �EasyStep Interview" is the only way to get a company set up on Quickbooks.
d. The �EasyStep Interview" requires the user to enter all applicable data for the company. There are no defaults set.

91.Which of the following is information that must be entered in the initial �EasyStep Interview" when setting up information about the company in Quickbooks?
a. The company's type of business entity.
b. Information on users of the system.
c. Custom fields for customers of the company.
d. The payroll system of the company.

92.There are additional steps that must be taken after the �EasyStep Interview" is complete. Which of the following
is not one of those steps?
a. Input historical information.
b. Set up payroll.
c. Input the Company information.
d. Set up users and passwords.

93.In QuickBooks, only part of the important financial information is captured by the chart of accounts. To keep the chart of accounts from being unwieldy and to improve the speed at which transactions are captured, QuickBooks uses all except which one of the following:
a. Subaccounts.
b. Classes.
c. Lists.
d. Items.
94.Sam has several locations of his dry cleaning business. He wants to prepare a budget for each location. He
should choose which of the following to create separate budgets for each location within his company?
a. Budget by customer: job.
b. Budget by price level.
c. Budget by profit and loss accounts.
d. Budget by class.

95.Which of the following most accurately reflects the capabilities of QuickBooks when setting up price levels?
a. QuickBooks cannot automate discount or write_up pricing using the price level feature.
b. Users cannot enter fixed percentage premiums and discounts.
c. Users cannot manually choose a price level when preparing an invoice.
d. QuickBooks can automatically apply price levels to specific customers.

96. Connie owns a catering business and wants to charge clients for vehicle mileage. Which is the best method she can use to include mileage charges on her invoices?
a. Enter the rate directly into the client's invoice.
b. Use a specific rate per mile selecting the Mileage Rates" button under the �Enter Vehicle Mileage" screen.
c. Include the percentage of actual auto expense used on behalf of the client.
d. QuickBooks does not allow mileage tracking as an item so charges must be calculated manually.

97. If sales tax was not set up during the �Easy Step Interview," which steps can be taken to activate the sales tax feature?
a. Select Preferences" under the Edit" menu and answer  Yes" to the question �Do You Charge Sales Tax?" in the Company Preferences" tab.
b. Select Sales Tax Liability" under the Reports" menu and answer Yes" to the question Do You Charge Sales Tax?" in the Company Preferences" tab.
c. Choose Sales Tax Item" from the List" menu and answer �Yes" to the question Do You Charge Sales Tax?" in the Company Preferences" tab.
d. Go to the Company" menu and choose �Set Up Sales Tax" and answer Yes" to the question Do You Charge Sales Tax?" in the �Company Preferences" tab.

98.A Sales Tax Payable" account:
a. Is automatically created by QuickBooks if the sales tax feature is turned on.
b. Must always be created manually by the user.
c. Is automatically created by QuickBooks, but only if the user completes the EasyStep Interview."
d. When historical sales transactions are entered, the user must enter the opening sales tax payable balance manually.

99. Which of the following is not a field when entering Purchasing Information" in the inventory feature?
a. Tax Code.
b. Description.
c. Cost.
d. Preferred Vendor.

100.Which of the following general ledger accounts should not be set up when the inventory feature is turned on:
a. Inventory asset.
b. Sales.
c. Cost of goods sold.
d. Tax codes.

101. If a user does not subscribe to one of the Intuit Payroll Services, the QuickBooks payroll feature cannot:
a. Maintain employee information.
b. Accumulate payroll liabilities.
c. Calculate state payroll taxes.
d. Calculate nontax deductions.

102.Karen is a practitioner whose clients frequently ask her which QuickBooks payroll option to use. Which of the following is not a question Karen needs to ask the clients in helping them determine the appropriate payroll option?
a. How much control does the client want?
b. Which bank handles payroll for the client?
c. How complex are the company's payroll benefits?
d. How many employees do they have?

103.If the QuickBooks full payroll" feature is selected, which of the following tasks will not be needed to set up payroll?
a. Review payroll data.
b. Specify payroll preferences.
c. Use the Payroll Setup Interview to enter employee information.
d. Generate payroll tax forms.

104. Stephanie is working on entering historical items when setting up QuickBooks for the company. Stephanie's
company bills expenses, such as travel, from her consultants to her clients. When working on setting up her
accounts payable, which should she enter first?
a. Historical accounts receivable transactions.
b. Historical accounts payable transactions.
c. Current unpaid bills.
d. Balances with vendors as of the setup date.
105. Stella wants to find the contact information on ABC Company. She sent a check to ABC Company in the past
but it is not one of her vendors. Where can she easily find the contact information for ABC Company?
a. Go to Lists" and click on Other Names" list.
b. Go to Lists" and click on Vendors" list.
c. Go to Lists" and click on Customer:Job" list.
d. Go to Lists" and click on Checks" list.

106. Sandy, the administrator of her company's QuickBooks program, asks all users to log off. Which activity is
Sandy most likely to perform?
a. Create financial reports.
b. Change Company Preferences."
c. Create and print transactions and forms.
d. Set up a new vendor.

107. Palm Tree Suites has been having problems with invoices being posted twice in QuickBooks. Is the system able
to notify the user when a duplicate bill number is being posted into the system?
a. Yes, in the Checking" preference dialog box.
b. Yes, in the Bills" preference dialog box.
c. Yes, in the Accounting" preference dialog box.
d. No, the system is not able to alert the user.

108.John is a professional accountant with numerous clients who send him their financial data from their different
versions of QuickBooks programs. In addition, John often helps his clients by troubleshooting issues they are
having with their QuickBooks. Which version of QuickBooks will enable John to support his clients most
effectively?
a. QuickBooks Pro.
b. QuickBooks Pro for Contractors.
c. QuickBooks Premier_Accountant.
d. QuickBooks Premier.

109. Martha is starting work on her client's QuickBooks data and has requested that the client forward the information to her, so that she can work with the data at her office, instead of on_site. The client would be able transmit the QuickBooks data to Martha in all the following methods, except:
a. Computer disks or CD_ROM.
b. Hard copy.
c. Email.
d. Shared disk files.

110. Which of the following statements is least accurate?
a. Practitioners using remote access software can adjust clients' QuickBooks data files.
b. Practitioners using remote access software can provide technical support and training.
c. Remote access software features are consistent from product to product.
d. Performance during file transfers and remote control sessions is a significant consideration when selecting
remote access software.

111.QuickBooks allows users to create an accountant's copy of the company's data files, which the practitioner may review and adjust while the client continues to process transactions in the original file. With an accountant's copy, a practitioner can perform all the following tasks except:
a. Generate new reports.
b. Modify inventory quantities and values.
c. Merge newly created inventory part items with existing inventory part items.
d. While working with the accountant's copy, make temporary changes to preferences.

112.Diana's accountant has adjusted her company file and she is ready to import the changes into her QuickBooks file. Upon opening the file, the extension should read:
a. .qby
b. .csv
c. .qbw
d. .pdf

113.The clean up data feature is most accurately described as:
a. A QuickBooks feature that stores transaction details that are no longer needed.
b. A QuickBooks feature that condenses QuickBooks transactions dated on or before a specified date.
c. A QuickBooks feature that expands the amount of data stored on the hard drive.
d. A QuickBooks feature that greatly reduces the file size by removing any inactive list items not used after
the date through which the data is cleaned up.

114.Calvin is reviewing his client's data in QuickBooks. He has already reviewed the general ledger and trial balance. To further research detail account information, which report should he open?
a. Balance Sheet Detail.
b. Profit and Loss Detail.
c. Transaction History Detail.
d. Transaction Detail by Account.

115.The correct method to adjust inventory values to update the inventory details in QuickBooks is to perform which of the following?
a. From the Vendors" menu, select Inventory Activities" and then Adjust Quantity/Value on Hand."
b. Select Make General Journal Entries" from the Company" menu.
c. Create a journal entry to adjust the inventory asset general ledger account balance.
d. Select Adjust Inventory" from the Vendors" menu.

116.Within the Premier_Accountant version of Quickbooks, the Fixed Asset Manager allows a practitioner to analyze
depreciation expense in numerous ways. How many different types of depreciation bases are available for the
practitioner to view?
a. 3.
b. 5.
c. 6.
d. 8.

117.When an asset is added to the Schedule of Assets in Fixed Asset Manager, users must select the applicable general ledger accounts. Identify which of the following is not one of the accounts:
a. Accumulated depreciation/amortization.
b. Asset description.
c. Depreciation/amortization expense.
d. Asset account.

118. Gabrielle's client is having cash flow problems and has the opportunity to refinance his company's business loan. Gabrielle can quickly evaluate the new loan terms by using which QuickBooks feature?
a. Cash Flow Projector.
b. Fixed Asset Manager.
c. Financial Statement Designer.
d. Loan Manager.

119. Name three methods to detect changes in prior year balances within QuickBooks.
a. Closing Date Exception Report, Transaction Account Detail, General Ledger.
b. Audit Trail Report, Journal Report, Opening Balance Equity.
c. Retained Earnings, Balance Sheet Detail, Profit and Loss Detail.
d. Balance Sheet Previous Year Comparison, Profit and Loss Previous Year Comparison, Opening Balance Equity.

120. A practitioner can generate which of the following income statement reports by selecting Company and Financial" from the Reports" menu?
I. Profit & Loss Detail.
II. Income & Expense Graph.
III. Profit & Loss Budget Performance.
IV. General Ledger
a. I. and IV.
b. II. and III.
c. I. and II.
d. III. and IV.

121. QuickBooks generates which one of the following statements?
a. A statement of cash flows.
b. A combined statement of income and retained earnings.
c. A separate statement of retained earnings.
d. A statement of changes in stockholders' equity.
15. Howard is preparing next year's budget. To access the budgeting function in QuickBooks, he should:
a. Select the Budget Overview" option from the Reports" menu.
b. Select the Planning & Budgeting" option from the Company" menu.
c. Select the Budget vs. Actual Graph" option from the Reports" menu.
d. Select the Profit and Loss Budget Performance" option from the Company" menu.

122. Which of the following statements describes the function of the Cash Flow Projector most accurately?
a. The Cash Flow Projector allows clients to project cash flow for the next 12 months.
b. The Cash Flow Projector's adjustments will change the information in the financial statement accounts.
c. The Cash Flow Projector is accessed through the Budgeting" selection from the Report" menu.
d. By using current and historical information from QuickBooks, cash flow can be projected easily using the cash flow projector.

123.When a preference to produce summary reports on the cash or accrual basis is selected, which of the following reports would be affected?
a. Profit and Loss Detail.
b. General Ledger.
c. Balance Sheet.
d. Transaction Detail by Account.

124. Barbara is preparing an accounts receivable aging report. She does not want the Memo column to appear in the report. Which tool in QuickBooks should she use to eliminate that column?
a. Filters.
b. Collapse.
c. Headers and Footers.
d. Auto Fit.

125.By clicking on Export" in the Export Report" window, QuickBooks will automatically open Excel and export report information. Which of the following pieces of report information is omitted from the export?
a. Formulas.
b. Row and column labels.
c. Report modifications.
d. Report headers and footers.
126.Michael is wanting to produce GAAP financial statements for his client so that the client can apply for a loan at a bank. The client currently keeps their financial information in QuickBooks Premier Accountant. Which ofthe following programs would allow Michael to utilize Excel and customize the financial statements?
a. Client Ledger System.
b. Xpert Write_Up for Windows.
c. Inacct.
d. Intuit Statement Writer.

127.There are three ways to invoice customers. Which of the following is not one of these ways?

A) Invoice from Purchase Order 

B) Invoice from Estimate 

C) Invoice for Time & Costs 

D) Invoice from Scratch 

128.Where can you view AND edit journal entries?

A) Balance Sheet Standard 

B) Journal report 

C) Make General Journal Entry window 

D) Custom Transaction Detail Report 

129.The Chart of Accounts

A) It is a graphical illustration of how all the accounts affect each other in the accounting 

B) Is a Chart of all the values and trends of each of your bank accounts 

C) Is a list of all "accounting" accounts such as income, expenses, assets, liabilities, and equity.  Where you can create new ones and edit existing ones 

D) It is the place where all the bank accounts are reconciled 

E) B, C, and D are Correct 

F) None of the Above 

130.Which menu would you access to create a new company budget?
A) The Edit menu 

B) The File menu 

C) The Company menu 

D) The List menu 

131.What does Accounts Payable mean?

It means these are values customers owe us, typically from open bills 

None of the above 

These are the total amount of money owed to our vendors from open bills 

It's a bank account that is only used to make payments 

A and B are Correct 

These are accounts used to pay for inventory that has not been received 

132.When viewing a detail level report, such as Open Invoices Report, what happens when you double click on an the amount shown on any particular transaction?

Lets you change the value from the report 

It will take you to one transaction where you can view or edit the individual transaction 

It allows you to see the formula of the calculated amount 

None of the Above 

133.What is a Sales Order?

A) It's a form utilized to order items that will be sold to you by your suppliers 

B)  Is a type of invoice used for retail business 

C) Is a Non-posting transaction used to log a sale before delivering the product or service. It is very useful to create back-orders when inventory is not in stock. 

D) It's a type of Bill that prepares the Accounts Payable during the order process 

E) None of the Above 

134.What would happen if you try to delete an item that was sold a couple of years ago, but has not been used in a while
A) It will save a record of the past usage but delete it  from the database so you cannot edit it.
B) It cannot be deleted, edited or inactivated.
 C) It will not let you delete it, instead you can make it inactive so it does not show as an option to use it.
 D) You can delete it, but your past financial statements will be affected
 E) None of the Above
135.Financial statements issued between the annual financial statements are referred to as __________________ financial statements

136.What is the best way to record a customer prepayment before the invoice has been created for the sale of inventory items on backorder?
A) Create a Sales Order, go to Receive Payment, and put in the memo field which SO is being prepaid
B) Go to Create Customer Pre-Payment on the Home Screen, choose the open SO's to apply the payment to
C) Create a Sales Order, Go to Record Deposit, choose the Customer that prepaid you, put in the account: Accounts Receivable, and put in the memo filed the SO to apply the payment to
D) All of the Above are Correct
E) Only A and C are Correct

137.Which of the following is NOT a reason to use a journal entry?
A) To enter year-end adjustments
B) Journal Entries are easier for non-accountants to use
C) To correct errors 
D) When there is no built-in form to enter a transaction

138.How do you access Support Resources?
A) Select Help:QuickBooks Help from the menu
B) Select Help:Access Support Resources from the menu
C) Select Help:Help and Support from the menu
The balance sheet reports amounts for a ______________ ______ time
A) period of
B) moment in

139.Which amount should be deducted from the balance per bank when preparing a bank reconciliation?
B) Deposits in transit 
C) Outstanding checks
140.Which menu would you access to create a new company budget?
A) The Edit menu
B) The File menu
C) The Company menu
D) The List menu
140.In the Desktop Version of QuickBooks, when Setting up a New Company File with the Step-by-Step Guide, it is important to keep in mind:
A) Once completed QuickBooks will create a company file on the cloud that only people with the correct username and password will be able to access.
B) The Interview Questions can never again be retrieved for the same company file, but the preferences can be changed in the Edit, Preferences menu and Company, Company Information menu 
C) Neither the Interview questions nor the preferences can be changed once the company file is set
D) None of the above
141.What is the best way to record a pre-payment for inventory to a vendor before the inventory has been received or the Bill created?
A) Create a Purchase order first, Go to Write Check, Choose the account: Accounts Payable, in the customer:job column put the vendor's name again, and finally put in the memo the PO number that is being pre-paid 
B) Go to Create Vendor Pre-Payment on the Home Screen, choose the open PO's to apply the payment to
C) Go to Record Deposit, choose the vendor you are paying the deposit to, put in the account: Accounts Receivable, and put in the memo filed the PO to apply the payment to
D) Go to Pay Bills, select Pre-Payment for PO's, and choose the open PO's to apply the payment to

142.A credit ________________ is an organization that provides information on customers' and potential customers' credit ratings

143.Restoring the amount of cash on hand in the petty cash fund to the amount reported in the general ledger is known as ______________________ the petty cash fund
144.In what two ways does QuickBooks use Account Type?
A) To determine which financial statement the account appears on, and which principle the account falls under
B) To determine which financial statement the account appears on, and how QuickBooks uses the account
C) To determine how QuickBooks uses the account, and which principle the account follows
D)Any of the above
145.What does Accounts Payable mean?
A) It's a bank account that is only used to make payments
B) These are accounts used to pay for inventory that has not been received
C) It means these are values customers owe us, typically from open bills
D) These are the total amount of money owed to our vendors from open bills
E) A and B are Correct
F) None of the above
146.Prior to approving a vendor's invoice for payment, the invoice, receiving ticket, and _______________ order should be compared

147.A bank debit memo is recorded with a credit to the company's Cash account
A) True
B) False
148.Commissions earned by a company's sales staff is part of the company's
A) Cost of goods sold 
B) Selling expenses
C) Other expenses
149.What does Accounts Receivable mean?
A) It's a bank account that only receives deposits.
B) These are accounts used to receive inventory.
C) It means these are values customers owe us, typically from open invoices.
D) These are the total amount of money owed to our vendors from open bills.
 
E) These are the invoices that were pre-paid before the product was delivered.
F) All of the above 
G) None of the Above
150.What is the difference between reconciling a Bank Account and a Credit Card Account?
A) You can only reconcile bank accounts, QuickBooks will not let you reconcile Credit Card Accounts.
B) Bank accounts are reconciled at detail level (transaction by transaction) and Credit Cards Reconcile only in totalized amounts in a bill.
C) They are essentially the same process, these are just two different types of accounts, but the reconciliation process is very similar.  Banks typically can have outstanding checks, but credit cards wouldn't.
D) You must setup a different company file for every account being reconciled.
E) None of the Above.
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